
1

Home 2
Product Parts 3
Control Panel Buttons and Lights 4
Control Panel Buttons 4
Control Panel Lights 5
Load Paper 6
Load Paper for Documents or Photos 6
Load Envelopes 8
General Paper Information 10
Print From Your Computer 15
Windows Printing 15
Mac OS X Printing 25
Print On a CD or DVD 33
Guidelines for Printing on CDs and DVDs 33
Load a CD/DVD 34
Print a CD/DVD From Your Computer 37
Refill Ink 48
Check Ink Levels 48
Purchase EPSON Ink Bottles 51
Precautions on Refilling Ink 52
Refill Ink Tanks 52
Adjust Print Quality 58
Clean the Print Head 58
Align the Print Head 63
Clean the Paper Guide 64
Solve Problems 65
Check for Software Updates 65
Problem-solving Tools 65
Problems and Solutions 68
Re-install Software 77
Get More Help 78
Clean and Transport Your Product 80
Cleaning 80
Transportation 80
Use Your Product on a Network 82
Windows 7, Windows Vista, and Windows XP Network Setup 82
Mac OS X Network Setup 83
Specifications and Notices 85
Important Safety Instructions 85
Computer System Requirements 87
Product Specifications 88
Copyright and Trademarks 93



2

Home
Welcome to the L800 User’s Guide. 
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Product Parts
Use these illustrations to identify the parts on your product.

Paper support

Output tray 
extensions

Edge guide

Sheet feeder

Output tray

Printer cover

Front cover

Ink tank unit

USB port
Power inlet
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Control Panel Buttons and Lights

Control Panel Buttons

Button Function

Press to turn the printer on and off.

Press to move the print head to its home position.
When the ink light is off, press and hold for at least 3 seconds to clean 
the print head.

Press to load or eject paper.
Press to resume printing after a paper out error or multiple page feed 
error.
Press to cancel printing during a print job.

Transportation lock

Print head

Ink tanks

Control panel

Ink tubes



5

Control Panel Lights

Light Description

On when the printer is on.
Flashes when the printer is receiving data, printing, charging ink, or 
cleaning the print head.

On when the ink level of one or more ink tanks may have reached the 
lower line.
Flashes when the ink level of one or more ink tanks may be low. You may 
continue printing until the ink level reaches the lower line.

On when the printer is out of paper or the CD/DVD tray is not loaded 
corretly.
Flashes when paper or the CD/DVD tray is jammed, or when the output 
tray is in an incorrect position.
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Load Paper
Before you print, load paper for the type of printing you will do.
Load Paper for Documents or Photos
Load Envelopes
General Paper Information

Load Paper for Documents or Photos
You can print documents and photos on a variety of paper types and sizes.
1. Open the paper support, then pull up the extension.

2. Open the front cover, then extend the output tray.

3. Squeeze the tab on the edge guide and slide it to the left.
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4. Insert paper, glossy or printable side up and short edge first, against the right side of the sheet 
feeder and place it behind the tabs on the edge guides.

5. Slide the edge guide against the paper, but not too tightly.

If you are inserting a stack of paper, fan the 
sheets first and tap the stack on a flat surface to 
even the edges. 

Smaller paper

Letter- or A4-size
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Tip:
Load only the recommended number of sheets. 
Load paper short edge first, no matter which way your document or photo faces.
Load letterhead or pre-printed paper top edge first.
Do not load paper above the arrow marks on the edge guide. 
Check the paper package for any additional loading instructions.
Leave enough space in front of the printer for the paper to be fully ejected.

Load Envelopes
You can print on plain paper envelopes in 4 1/8 × 9 1/2 inch (#10) (105 × 241 mm) size. 
1. Open the paper support, then pull up the extension.
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2. Open the front cover, then extend the output tray.

3. Squeeze the tab on the edge guide and slide it to the left.
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4. Load up to 10 envelopes against the right side. Load them printable side up and flap edge left 
and behind the tabs on the edge guides.

Tip:
Press each envelope flat before loading it or load one envelope at a time.

5. Slide the edge guide against the envelopes, but not too tightly.

Tip:
Do not use envelopes that are curled or folded, and avoid using envelopes that are too thin 
because they may curl during printing. Before printing from your computer, select Envelope as 
the paper type, Envelope #10 as the paper size, and Landscape as the orientation. If you are 
printing on envelopes of a different size, create a custom size in Windows or Mac OS X.

General Paper Information
Media Loading Capacity
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Available EPSON Papers
Borderless Paper Types and Sizes
Type or Media Type Settings for Loaded Paper

Media Loading Capacity

* Availability of media varies by country.

Available EPSON Papers

Paper type* Load up to this many sheets

Plain paper 
EPSON Presentation Paper Matte

100 sheets

EPSON Bright White Paper Up to 80 sheets

EPSON Photo Paper Glossy
EPSON Premium Photo Paper Glossy
EPSON Premium Photo Paper Semi-gloss
EPSON Ultra Premium Photo Paper Glossy
EPSON Premium Presentation Paper Matte

20 sheets

EPSON Premium Presentation Paper Matte Double-sided
EPSON Photo Quality Self-adhesive Sheets
EPSON Iron-on Cool Peel Transfer paper

1 sheet

Paper type Size Part number Sheet 
count

EPSON Bright White Paper Letter (8.5 × 11 inches 
[216 × 279 mm])

S041586 500

EPSON Photo Paper Glossy 4 × 6 inches (102 × 152 
mm)

S041809-20
S041809
S042038

20
50
100

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041141
S041649
S041271

20
50
100

A4 (8.3 × 11.7 inches 
[210 × 297 mm])

S041140 20
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EPSON Premium Photo Paper Glossy 4 × 6 inches (102 × 152 
mm)

S041808
S041727

40
100

5 × 7 inches (127 × 178 
mm)

S041464 20

8 × 10 inches (203 × 254 
mm)

S041465 20

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042183
S041667

25
50

EPSON Ultra Premium Photo Paper 
Glossy

4 × 6 inches (102 × 152 
mm)

S0412174 100

5 × 7 inches (127 × 178 
mm)

S041945 20

8 × 10 inches (203 × 254 
mm)

S041946 20

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042182
S042175

25
50

EPSON Premium Photo Paper Semi-
gloss

4 × 6 inches (102 × 152 
mm)

S041982 40

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041331 20

EPSON Presentation Paper Matte Letter (8.5 × 11 inches 
[216 × 279 mm])

S041062 100

EPSON Premium Presentation Paper 
Matte

8 × 10 inches (203 × 254 
mm)

S041467 50

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041257
S042180

50
100

EPSON Premium Presentation Paper 
Matte Double-sided

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041568 50

EPSON Photo Quality Self-adhesive 
Sheets

A4 (8.3 × 11.7 inches 
[210 × 297 mm])

S041106 10

EPSON Iron-on Cool Peel Transfer 
paper

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041153 10

Paper type Size Part number Sheet 
count
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Note:
Availability of paper types varies by country.
You can purchase genuine EPSON ink and paper from an EPSON authorized reseller. To find the 
nearest one, contact Epson.

Borderless Paper Types and Sizes

Type or Media Type Settings for Loaded Paper

Borderless paper type Borderless paper size

EPSON Photo Paper Glossy 4 × 6 inches (102 × 152 mm)
Letter (8.5 × 11 inches [216 × 279 mm])

EPSON Premium Photo Paper Glossy 4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
Letter (8.5 × 11 inches [216 × 279 mm])

EPSON Ultra Premium Photo Paper Glossy 4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
Letter (8.5 × 11 inches [216 × 279 mm])

EPSON Premium Photo Paper Semi-gloss 4 × 6 inches (102 × 152 mm)
Letter (8.5 × 11 inches [216 × 279 mm])

EPSON Premium Presentation Paper Matte Letter (8.5 × 11 inches [216 × 279 mm])

For this paper/media Select this paper Type or Media 
Type setting

Plain paper
EPSON Bright White Paper

Plain Paper/Bright White Paper

EPSON Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy

EPSON Premium Photo Paper Glossy Premium Photo Paper Glossy

EPSON Photo Paper Glossy Photo Paper Glossy

EPSON Presentation Paper Matte Presentation Paper Matte

EPSON Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss

EPSON Premium Presentation Paper Matte
EPSON Premium Presentation Paper Matte Double-
sided
EPSON Photo Quality Self-adhesive Sheets
EPSON Iron-on Cool Peel Transfer paper

Premium Presentation Paper Matte

CDs/DVDs CD/DVD



14

Envelopes Envelope

For this paper/media Select this paper Type or Media 
Type setting
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Print From Your Computer
After you connect the printer to your computer and install its software, you can print documents 
and photos from your computer.
Follow the instructions in these sections to print documents and photos:
Windows Printing
Mac OS X Printing
To print on CDs/DVDs, follow the steps in Print on a CD or DVD.
Before you print, make sure you installed your software and connected the printer to your 
computer; see the Start Here sheet for instructions.
Tip:
It’s a good idea to check for updates to your printer software (see Check for Printer Updates for 
instructions).
Also be sure to load paper in the sheet feeder.

Windows Printing
You can print using any Windows® printing program. Follow the steps in these sections:
Print From a Program
Select Basic Options
Change Print Layout
Select Advanced Options
Print Your Document or Photo
Check Printing Status
Change Default Print Settings
Change the Language
See also:
Mac OS X Printing

Print From a Program
After you open a document or photo in a Windows program, follow these steps to access your 
print settings:
1. Select the print option from your application.
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2. Select EPSON L800 Series.
3. Click Properties or Preferences.

Note:
If you don’t see these buttons, click Setup, Printer, or Options, then click Properties or 
Preferences on the next screen.
Your printer settings window opens:
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Follow the steps in these sections to select settings, print, and control printing:
Select Basic Options
Change Print Layout
Select Advanced Options
Print Your Document or Photo
Check Printing Status
Change Default Print Settings

Select Basic Options
There are two ways to select basic printing options:
• Select a printing preset to quickly select settings for common paper types, sizes, and print 

qualities.
• Select individual settings on the Main tab.

Select a Printing Preset

For quick access to the most common settings, click the Shortcuts tab. Point to one of the 
Printing Presets to view a list of the settings for it.
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If the settings are correct for your print job, click the preset and print.
To create your own presets, click on the Advanced tab, select your settings, and then click on the 
Save Settings button.
To delete a preset you created, click Add/Remove on the Shortcuts tab, select the preset, and click 
Delete.

Select Basic Settings on the Main Tab

Click the Main tab at the top of the printer settings window to select your basic print options.
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Tip:
For information about an option, move the mouse over the setting or right-click it to access the 
Help utility.
Note:
When printing borderless photos, part of the image will be cropped because this option enlarges 
the image slightly beyond the paper size. Adjust the image to the size of the paper and set the 
margins in your application to zero.
1. Select a Source option (if you are printing on paper, select Sheet).
2. Select a Quality Option that matches your document or photo and the print quality you want.
3. Select the paper type setting that matches the paper you loaded.
4. Select the paper size setting for the paper you loaded. A User Defined option is also available 

so you can create a custom size.
5. If you’re printing borderless photos, select Borderless. For documents or photos with borders, 

select Borders.
Note:
For borderless photos, make sure you loaded a compatible borderless paper size and type.

6. Select any of the Print Options you want for your document or photo—such as Fix Photo to 
improve the color, contrast, and sharpness of flawed photos—or Quiet Mode to lessen noise 
during printing when Plain Paper/Bright White Paper is selected for the paper Type.
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Note:
Fix Photo uses a sophisticated face recognition technology to optimize photos that include 
faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your 
photo includes a face with an intentional color cast, such as a statue, you may want to turn off 
Fix Photo to retain the special color effects.

7. Choose Portrait or Landscape orientation for your document or photo. (Choose Landscape 
for printing envelopes.)

You can also:
• Select different print layout settings
• Select advanced printing options
• See a summary of your settings (click Show Settings)
• Return to the default settings (click Reset Defaults)
• Access the Epson support website (click Online Support; website is available in Spanish and 

Portuguese)
When you’re finished, you’re ready to print.

Change Print Layout
You can select a variety of sizing and layout options on the Page Layout tab.
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• To size your printed document or photo, click the Reduce/Enlarge Document checkbox and 
select sizing options.

• To print on both sides of your paper, select On for 2-sided printing and adjust the margins or 
select Folded Booklet as necessary.

• To print multiple pages on one sheet, or one image across multiple sheets, click the Multi- 
Page checkbox and select the multi-page options you want for your document.

• To select multiple copies and their print order, use the Copies, Reverse Order, and Collate 
options.

• To adjust the amount of image expansion when printing borderless photos, select Auto 
Expand as the Enlargement Method, then adjust the Borderless Expansion slider to Min, 
Mid, or Max. (If you select Retain Size, the image is printed at its actual size without 
scaling.)
Note:
You may see white borders on your printed photo if you use the Min setting.

• To add a watermark message to your printed document or photo, select a Watermark setting.
• To rotate or flip the image you’re printing, click the Rotate 180° or Mirror Image 

checkboxes.
See also:
Select Basic Options
Select Advanced Options
Print Your Document or Photo

Select Advanced Options
Click the Advanced tab at the top of the printer settings window to select Advanced options.
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1. Select the paper type setting that matches the paper you loaded.
2. Select the print quality setting for your document or photo, such as Fast Economy for the 

fastest printing or Photo or Photo RPM for the best print quality.
Note:
Available print quality settings depend on the selected paper type setting.

3. Select the paper size setting for the paper you loaded. A User Defined option is also available 
so you can create a custom size.

4. If you’re printing borderless photos, select Borderless. For documents or photos with borders, 
select Borders.
Note:
For borderless photos, make sure you loaded a compatible borderless paper size and type.

5. Choose Portrait or Landscape orientation for your document or photo. (Choose Landscape 
for printing envelopes.)

6. Select any of the Print Options you want for your document or photo.
7. Select Color Management options for finer control of the color in your document or photo.
You can also:
• Save all your selected settings for later use (click Save Settings and name the settings); to use 

saved settings later, select them from the Custom Settings list or from the Shortcuts tab
• Return to the default settings (click Reset Defaults)
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• Select different print layout settings
• Select basic printing options
When you’re finished, you’re ready to print.

Print Your Document or Photo
After selecting your print settings, click OK to save them and return to the Print window.

Click OK or Print to start printing.
During printing, you can check printing status.

Check Printing Status
During printing, you see this window showing the progress of your print job. It allows you to 
control printing and check ink levels.

To cancel printing, click Stop.
To see print jobs lined up for printing, click Print Queue.
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To check ink status, click Check Ink Levels.
If you see an error during printing, see Solve Problems for solutions.
Note:
You can also cancel printing by pressing the printer’s paper button.

Change Default Print Settings
When you change your print settings from within a program, the changes apply only while you’re 
printing at that time. If you want to select different settings to use in all your Windows programs, 
you can change the default print settings.
1. Right-click the printer icon in the taskbar.
2. Select Printer Settings. You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
You can still change the default settings from within a program as needed.

Change the Language
In Windows, you can choose English, Spanish or Portuguese as the language of the printer 
software screens.
1. Right-click the printer icon in the taskbar and select Printer Settings.
2. Click the Maintenance tab.
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3. Select the language you want to display.
4. Click OK to close the driver screen. The language used on the driver screen changes to your 

selection the next time you access it.

Mac OS X Printing
You can print using any Mac OS X printing program.
Follow the steps in these sections to print from your Mac:
Open Your File for Printing
Select Basic Print Options
Select Page Setup Options
Change Print Layout
Manage color
Print Your Document or Photo
Check Printing Status
General Printing Preferences
See also:
Windows Printing

Open Your File for Printing
You can open a file for printing by either:
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• Starting a printing program and opening a document or photo from it.
• Double-clicking a document or photo file icon on the screen.
When you’re ready to print, select print options and then print.

Select Basic Print Options
After opening your file for printing, open the print window to select your print options.
1. Open the File menu and select Print.
2. Select the name of your EPSON product as the Printer setting.

3. If necessary, click the Show Details button or the button next to the Printer setting to 
expand the print window.

4. Select the page setup options. Choose the Paper Size and Orientation settings.
Note:
If you don’t see these settings here, check for them in your application before printing. For 
example, you may be able to select them by opening the File menu and selecting Page Setup.

5. Select any settings that are specific to the application you’re using. For example, if you’re 
printing from Preview, you see the application settings shown above. 

6. Select Print Settings from the pop-up menu.
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These settings appear on the screen:

7. Select the Media Type setting that matches the paper you loaded.
8. Select a Print Quality for your document or photo. Available settings depend on the selected 

Media Type setting.
You can also:
• Select page setup options
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• Select different print layout settings
• Manage colors
When you’re finished, you’re ready to print.

Select Page Setup Options
Depending on your application, you may be able to select the paper size and orientation settings, 
and adjust the size of your printed document or photo, from the print window.

Note:
If you don’t see these settings in the print window, check for them in your application before 
printing. For example, you may be able to select them by opening the File menu and selecting 
Page Setup.
1. Select the Paper Size setting for the paper you loaded. A custom option is also available so 

you can create a custom paper size.
2. Choose a portrait or landscape Orientation option for your document or photo. (Choose 

landscape left for envelopes.)
You can also:
• Select basic print options
• Select different print layout settings
• Manage colors
When you’re finished, you’re ready to print.

Change Print Layout
Select Layout from the pop-up menu to select a variety of layout options.
1. Select Layout in the pop-up menu.

2. Select from the following options, as necessary:



29

To print multiple pages on one sheet, select 2, 4, 6, 9, or 16 in the Pages per Sheet pop-up 
menu.
Select the order in which the multiple pages print on the sheet as the Layout Direction 
setting.
To print borders around each page, select one of the line settings in the Border pop-up menu.
You can also flip the direction of your image by selecting Reverse page orientation or Flip 
horizontally.

You can also:
• Select basic print options
• Select page setup options
• Manage colors
When you’re finished, you’re ready to print.

Manage color
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your 
printout, or turn off color management in your printer software.
1. Select Color Matching in the pop-up menu.

2. Select from the following options, if necessary:
EPSON Color Controls lets you manage color using controls in your printer software, or turn 
off color management.
ColorSync prints using standard color profiles for your product and paper to help match 
image colors.

3. Select Color Options in the pop-up menu.

Note:
The available settings on the Color Options menu depends on the option you selected on the 
Color Matching menu.

4. Select from the following options, if necessary:
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Manual Settings lets you select manual color adjustments. Click the arrow next to Advanced 
Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. 
You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye 
setting to reduce or remove red-eye in photos. If you select the Adobe RGB color mode, you 
can also adjust the midtone density using the Gamma setting.
Fix Photo to improves the color, contrast, and sharpness of flawed photos. Click the arrow 
next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in 
photos.

Fix Photo uses a sophisticated face recognition technology to optimize photos that include 
faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your 
photo includes a face with an intentional color cast, such as a statue, you may want to turn off 
Fix Photo to retain the special color effects.
Off (No Color Adjustment) turns off color management in your printer software so you can 
manage color using only your application software.

You can also:
• Select basic print options
• Select page setup options
• Select different print layout settings
When you’re finished, you’re ready to print.

Print Your Document or Photo
After selecting your print settings, click Print to start printing.
During printing, you can check printing status.

Check Printing Status
During printing, you can view the progress of your print job and control printing.
1. Click your product icon when it appears in the Dock.
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2. Select from these options:
• To cancel printing, click the print job and click Delete.
• To pause printing for a specific print job, click the print job and click Hold. To resume 

printing, click the print job marked “Hold” and click Resume.
• To pause printing for all print jobs, click Pause Printer.
• To check ink status, click Supply Levels.
Note:
You can also cancel printing by pressing the printer’s paper button.

3. When you’re finished, close the window to exit the program.
If you see an error during printing, see Solve Problems for solutions.

General Printing Preferences
You can select various printing preferences that will apply to all print jobs.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax or Print & Scan.
3. Make sure your printer is selected, then click the Options & Supplies button.
4. Click the Driver tab. You see this screen:
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5. Select the following options:
• Thick paper and envelopes prevents ink from smearing when you print on envelopes or 

other thick paper.
• Skip Blank Page to ensure that pages without text or images are not printed
• Quiet Mode for quieter printing when Plain Paper/Bright White Paper is selected as the 

Media Type
• High Speed Printing for faster printing; print quality is reduced.
• Warning Notifications lets you choose whether or not to receive warning notifications 

from the printer software when ink is low.
6. Click OK when done.
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Print On a CD or DVD
You can use your product to print a design right onto ink jet-printable CDs or DVDs to create a 
custom label. You can do this using the EPSON Print CD software that came with your product.
Follow the steps in these sections to:
Guidelines for Printing on CDs and DVDs
Load a CD/DVD
Print a CD/DVD From Your Computer
Note:
If you’re using discs where the printable area extends to within 0.16 inch (4 mm) of the edge of 
the center hole, you may need to adjust the inner diameter setting in the File menu of the EPSON 
Print CD software.

For best results, Epson recommends printing on ink-jet printable CDs and DVDs with a white 
surface.

Guidelines for Printing on CDs and DVDs
• Use only ink jet-printable CDs and DVDs for printing. Thermal-printable and regular CDs 

and DVDs should not be used with this printer.
• Make sure the data, music, or video is burned on your ink jet-printable CD or DVD before you 

print. Otherwise, fingerprints, dirt or scratches on the surface may cause errors when you burn 
the data.

• Always use the small CD/DVD adapter when you print on 8-cm discs, and make sure the disc 
and adapter lie flat on the tray; otherwise the printer may be damaged.

• Print only on circular CDs/DVDs.
• Store the CD/DVD tray in a flat place. A warped or damaged CD/DVD tray may stop the 

printer from operating normally.
• Before you insert the disc, make sure that no dust or dirt is on the CD/DVD tray, as this may 

damage the disc’s data side. 
• Do not insert the CD/DVD tray while the printer is printing; otherwise, your printer may be 

damaged or the surface of the disc may become dirty or scratched.
• Insert one disc at a time.
• Be sure to use the CD/DVD tray provided with this printer. If you use another tray, there may 

be a gap in the print position and printing may not be performed properly.
• Before using or touching the printed surface of your discs, make sure you let them dry 

completely. 
• Keep printed discs away from moisture and direct sunlight and handle them carefully.
• Depending on your disc type, smearing may occur even after it has dried. If smearing or 

stickiness occurs, you may need to adjust the print quality or try a different brand of CD or 
DVD.
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• Test print on a spare CD/DVD and check the printed surface after waiting for one full day, 
especially before printing a large number of CDs/DVDs.

• If the printed surface is sticky even after it has dried, the color saturation may be too high. If 
this occurs, adjust the level of color correction from the Print screen in EPSON Print CD.

• If the print position is misaligned, adjust it using EPSON Print CD. 
• A lower level of color saturation is used to ensure print quality when printing on a CD/DVD, 

as opposed to EPSON special paper.
• Reprinting on the same CD/DVD may not improve the print quality.
• Moisture on the printable surface of your discs may cause smearing.
• If you accidentally print on the CD/DVD tray or on the transparent center of the CD/DVD, 

immediately wipe off the ink.
• If the tray is ejected or not fed correctly when you start a CD/DVD print job, make sure that 

you inserted the tray properly.
• If the tray is ejected when you start a CD/DVD print job, the printer is not ready. Wait until 

you see a message on your screen asking you to insert the tray. Then reinsert the tray and press 
the paper button.

• Do not turn the printer off with a CD or DVD loaded in it. Always remove the disc first.
• You can set the printable area for your discs using EPSON Print CD. Make sure the settings 

you choose are appropriate for the CD or DVD you are printing on; otherwise, you may stain 
the CD/DVD tray or disc.

• The printable area of a CD or DVD is shown below:

Note:
Avoid printing in the clear plastic areas of discs to prevent staining the disc with ink.
• Inner hub area: 18 to 42 mm
• Outer periphery area: 117 to 120 mm (12-cm CD/DVD), 77 to 80 mm (8-cm CD/DVD)

Load a CD/DVD
You can print on any compatible, ink jet-printable CD or DVD.

12-cm CD/DVD 8-cm CD/DVD
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Note:
If you’re using discs where the printable area extends to within 0.16 inch (4 mm) of the edge of 
the center hole, you may need to adjust the inner diameter setting in the File menu of the EPSON 
Print CD software.

Before printing on a CD/DVD, it is necessary to clean the roller inside the printer by feeding and 
ejecting Letter- or A4-size paper. Load plain paper and press the paper button to feed and 
eject paper several times.
1. First burn files, music, or video onto your CD/DVD before printing on it to prevent errors.
2. Before you insert a disc, make sure the printer is turned on. Otherwise, the disc may not be 

positioned correctly. 
3. Open the front cover.

4. Lift the output tray up with both hands, then pull it out of the paper position (lower notches).

5. Place the output tray in the CD/DVD position (upper notches).
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6. Place the disc on the CD/DVD tray with the white or printable side face-up. Make sure the 
disc lies flat in the tray.
To print on a small disc (8-cm), place the small CD/DVD adapter on the tray first, then place 
the disc inside the adapter.

Caution:
Before positioning the CD/DVD, make sure that no foreign particles or substances are on the 
CD/DVD tray, as these may damage the CD/DVD’s data side.

Be sure to use the CD/DVD tray provided with this printer. If you use another CD/DVD tray, 
there may be a gap in the print position and printing may not be performed properly.

7. Gently insert the CD/DVD tray along the base of the output tray until the arrows on the CD/
DVD tray and the output tray are aligned. Make sure both sides of the CD/DVD tray slide into 
the brackets on the output tray.

8-cm CD/DVD12-cm CD/DVD

CD/DVD 
adapter
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Now you can print on the CD/DVD using the EPSON Print CD software on your computer.
After printing, remove the printed CD/DVD.

Print a CD/DVD From Your Computer
If you installed the EPSON Print CD software when you installed your product software, you can 
use it to create designs and print on CDs/DVDs.
Follow the instructions in these sections to print on a CD/DVD using EPSON Print CD:
Design a CD/DVD
Print a CD/DVD
Adjust Print Position
Adjust Print Quality

See also:
Load a CD/DVD

Design a CD/DVD
You can use EPSON Print CD to design your CD/DVD by importing photos, adding text, and 
creating special effects.
Follow the instructions in the section for your operating system.
Windows
Mac OS X

Windows

1. Double-click the Print CD icon on your desktop.
2. To select an image to use in the background, click the Background button.
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3. Select the image you want to use.

• Click the File tab.
• Click Browse, select the folder where your image is located, and click OK.
• Select the image you want to use and click OK to use the image as is. 
• To adjust the image, select the options on the right side of the window.

4. Click OK to close the Select Background window.
5. To make additional adjustments, click the Background button again.

• Click the Image Adjustment button and tab.
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• Adjust any of the necessary settings and click OK.
6. Click OK to close the Select Background window.
7. To add text, click the Text button.

• Enter your text in the Text box.
• Select the font, size, and other text effects by accessing them through the Text Settings, 

Text Color, and other tabs.
Note:
For more details on EPSON Print CD options, click Help.

8. Click OK to close the Text Settings window.
9. When you’re finished, open the File menu, select Save, and save your design file.
Once your design is saved, you can load the CD/DVD and print your design on it.
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Mac OS X

1. Select Applications > EPSON Software > Print CD.

2. To select an image to use in the background, click the background icon.

• Click Select Background.



41

• Select your image folder, select your image, and click Open.
• Click OK to use the image as is.
• To adjust the image, select the options on the right side of the window.

3. To further adjust the image, use the tools and sliders in the Adjust Background window. Then 
click OK.

4. To add text, click the text button.

• Enter your text in the Text Settings box.
• Select the font, size, and other text effects in the options below or on the Distort Text tab.
Note:
For more details on EPSON Print CD options, click Help.

5. When you’re finished, open the File menu, select Save, and save your design file.
Once your design is saved, you can load the CD/DVD and print your design on it.

Print a CD/DVD
After designing your CD/DVD and loading the disc, you’re ready to print on the CD or DVD 
using EPSON Print CD.
1. Open the File menu and, if necessary, open your CD design file, then select Print.
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2. Select your EPSON printer.
3. Click Print.
4. Remove the printed CD/DVD from the printer.
If you need to adjust the print position or print quality, see:
Adjust Print Position
Adjust Print Quality

Adjust Print Position
If your printed design is not positioned on your disc correctly, you can adjust the print position 
using an extra CD/DVD. 
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1. Load the CD/DVD.
2. Print an adjustment pattern and adjust the position as instructed for your computer:

Windows Adjustment
Mac OS X Adjustment

When you’re finished, you can burn another CD or DVD and print your design again.

Windows Adjustment

1. Open EPSON Print CD.
2. Open the File menu and select Print.
3. Select your EPSON printer as the Printer setting, if necessary.

4. Click Print Position Confirmation Pattern.
5. Click Print.
6. Remove the disc after printing.
7. Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and 

Right.
Note:
Be sure to measure from the edge of the hole and not the edge of the printable area.

8. Open the File menu, click Print, then click Adjust Print Position.



44

9. Click Enter Values, then select the distance for Top in the Height (Top) box and the distance 
for Right in the Width (Right) box.

10. Click OK.
Now you can burn another CD or DVD and print your design again.

Mac OS X Adjustment

1. Open EPSON Print CD.
2. Open the File menu and select Print.
3. Make sure your EPSON printer is selected.
4. Click Print Position Check Pattern.
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5. Click Print. 

6. Remove the disc after printing.
7. Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and 

Right.
8. Click Position Adjustment.

9. Click Value Entry, then select the distance for Top into the Top Space box and the distance 
for Right in the Right Space box.

10. Click OK.
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Now you can burn another CD or DVD and print your design again.

Adjust Print Quality
If ink smears on your disc design, you can adjust the color saturation and ink density using an 
extra CD/DVD. This may be necessary to make sure your designs look their best on the particular 
brand of discs you’re using.
1. Load the CD/DVD into the product.
2. Print a density pattern and correct the saturation and ink density as instructed for your 

operating system:
Windows Adjustment
Mac OS X Adjustment

When you’re finished, you can burn another CD or DVD and print your design again.

Windows Adjustment

1. Open EPSON Print CD.
2. Open the File menu and select Print.
3. Select your EPSON printer as the Printer setting.
4. Click Print Density Confirmation Pattern.

5. Click Print to print the density pattern on the CD/DVD. 
6. Remove the CD/DVD after printing.
7. Examine the CD/DVD to see if you need to make the density darker or lighter.
8. Insert the same CD/DVD again.
9. Open the File menu and select Print.
10. Adjust the Print Color Correction slider to a darker or lighter setting. 
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11. Click Print Density Confirmation Pattern, then click Second or Third to print additional 
patterns using different settings.

12. Click Print to print a new pattern in another position on the same CD/DVD.
13. Examine the CD/DVD again and, if necessary, adjust the settings and print again. 
14. Let the disc dry for at least 24 hours and check the results. If necessary, adjust the density 

again.
Now you can burn another CD or DVD and print your design on it.

Mac OS X Adjustment

1. Open EPSON Print CD.
2. Open the File menu and select Print.
3. Make sure your EPSON printer is selected.
4. Click Print Density Check Pattern.
 

5. Click Print. 
6. Remove the disc after printing and examine it to see if you need to make the density darker or 

lighter.
7. Load the same disc again.
8. Select a darker or lighter setting in the Color Correction box. 
9. Click Second Time or Third Time to print additional patterns using different settings.
10. Click Print to print a new pattern in another position on the same disc.
11. Examine the disc again and, if necessary, adjust the settings and print again. 
12. Let the disc dry for 24 hours and check the results. If necessary, adjust the density again.
Now you can burn another CD or DVD and print your design on it.
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Refill Ink 
You can refill an ink tank when the ink alert message appear on your computer screen and the ink 
level is below the lower line on the ink tank. 
You can monitor the approximate ink levels from your computer and view on-screen instructions 
for refilling ink. Your product and its software will let you know when an ink tank may be low or 
needs to be refilled. If ink is low but the ink level is above the lower line on the ink tank, the ink 
light may flash. You can continue printing until the ink tank needs to be refilled.
When you need to refill ink, click the How to button on the EPSON Status Monitor screen and 
follow the on-screen instructions or follow the steps in Refill ink tanks. You must refill the tank to 
be able to print. You cannot print when any ink tank is expended even if the other ink tanks are not 
expended.
Note:
For best printing results, use up the ink by the date printed on the ink bottle.
Follow the instructions in these sections to check and refill the ink tanks:
Check Ink Levels
Purchase EPSON Ink Bottles
Precautions on Refilling Ink
Refill Ink Tanks

Check Ink Levels
You can check the ink status using your Windows or Mac OS X software. If the screens shown 
below indicate that a tank is empty, refill the tank with the correct color.

Windows
Double-click the printer icon in the Windows taskbar and select EPSON L800 Series, if 
necessary. You see this window:
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The progress meter appears automatically when you start a print job. You can check the 
approximate ink levels from this window. Click the Check Ink Levels button on the progress 
meter screen to display the approximate ink levels as shown below:

You may also see this screen every time you print (if your computer is connected to the Internet):
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Select Do not display this message again and click Decline to disable online offers. Promotional 
offers are not valid in Latin America.
If you cannot check the ink levels from the printer driver, make sure that the Disable EPSON 
Status Monitor 3 checkbox is not selected by clicking the Speed & Progress button on the 
Maintenance window of the printer driver. If it is selected, you cannot check the ink levels and 
refill ink.

Mac OS X
1. In the Apple menu or the Dock, select System Preferences.

Mac OS X 10.6/10.7: Select Print & Fax or Print & Scan, select your product and select 
Options & Supplies. Select Utility and select Open Printer Utility.
Mac OS X 10.5: Select Print & Fax, select your product and select Open Print Queue. 
Select Utility.

2. Select EPSON Status Monitor.
You see this window:
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Purchase EPSON Ink Bottles
You can purchase genuine EPSON ink and paper from an EPSON authorized reseller. To find the 
nearest one, contact Epson.
Use these part numbers when you purchase new ink bottles and use the ink by the date printed on 
the package:

Note:
Ink yields vary considerably based on images printed, print settings, paper type, frequency of use, 
and temperature. For print quality, a small amount of ink remains in the tank after the “refill ink” 
indicator comes on. The printer ships with full ink bottles and part of the ink from the first bottles 
is used for priming the printer.

The ink bottles that came with your printer have a lower yield due to the ink charging process. 
This process is carried out the first time you turn on the printer and guarantees better performance. 
Don’t load paper before refilling ink tanks.

Ink color Part number

Black T6731

Cyan T6732

Magenta T6733

Yellow T6734

Light Cyan T6735

Light Magenta T6736
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Precautions on Refilling Ink
• We recommend the use of genuine EPSON ink bottles. Epson cannot guarantee the quality or 

reliability of non-genuine ink. The use of other products may affect your print quality could 
result in printer damage.

• Other products not manufactured by Epson may cause damage that is not covered by Epson’s 
warranties and under certain circumstances may cause erratic printer behavior.

• Keep ink bottles out of the reach of children. Do not allow children to drink from or handle the 
ink bottles and ink bottle cap.

• The printer requires careful handling of ink. Ink may splatter when the ink tanks are filled or 
refilled with ink. If ink gets on your clothes or belongings, it may not come off.

• Be careful not to touch any ink when you handle the ink tanks, ink tank caps, and opened ink 
bottles or ink bottle caps. If ink gets on your skin, wash the area thoroughly with soap and 
water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision 
problems continue after a thorough flushing, see a doctor immediately.

• Do not open ink bottles until you are ready to use them. 
• Continue using the printer until the ink level reaches the lower line so that the ink tank can be 

refilled with the entire contents of a new ink bottle.
• This printer uses IDs that are indicated on each ink bottle to fill or refill ink. IDs are only valid 

one time.
• Some ink is consumed from all ink tanks during the print head cleaning.
• Store the ink bottles in the same environment as the printer. When storing or transporting an 

ink bottle after removing its seal, do not tilt the bottle and do not subject it to impacts or 
temperature changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened 
securely. Be sure to keep ink bottle upright when tightening the cap, and take measures to 
prevent ink from leaking when you transport the bottle.

• When the ink alert message appears on your computer screen, you can click the Continue 
button to continue printing if the ink level is above the lower line on the ink tank. If the ink 
level is below the lower line on the ink tank, refill the ink soon. Continued use of the printer 
when the ink level is below the lower line on the tank could damage the printer.

Refill Ink Tanks
You can refill an ink tank when the ink alert message appears on your computer screen and the ink 
level is below the lower line on the ink tank.
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You can monitor the approximate ink levels from your computer and view on-screen instructions 
to refill the ink.
You must use the printer driver to refill the ink. Click the How to button in the EPSON Status 
Monitor window and follow the on-screen instructions, or follow the instructions below to refill 
ink.
Warning:
Keep the ink bottles out the reach of children and don’t drink the ink.
Caution:
For best printing results, use up the ink bottle before the date printed on the package.
Note:
The illustrations show how to refill the black ink. However, the instructions are the same for all of 
the inks.

Use gloves and place a sheet of paper under the ink tank when refilling ink. If ink spills, wipe off 
the ink immediately to prevent accidental staining of objects.
1. Make sure the power light is on, but not flashing.
2. Unhook the ink tank unit from the printer and lay it down. 
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Caution:
Do not pull the ink tubes.

3. Open the ink tank unit cover, and then remove the ink tank cap.

Note:
Be careful not to spill any ink.

Make sure that the color of the ink tank matches the ink color that you want to refill.
4. Snap off the tip of the bottle cap, remove the cap of the ink bottle, remove the seal from the 

bottle, and then install the cap.

1

2

1

2
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Note:
Do not throw away the tip of the bottle cap. If any ink remains in the ink bottle after refilling 
the tank, use the top of the cap to seal the ink bottle cap.

5. Refill the ink tank with the correct colored ink up to the upper line on the ink tank.

Note:
If any ink remains in the ink bottle after filling the ink tank up to the upper line, install the cap 
securely and store the ink bottle upright for later use.

6. Install the cap onto the ink tank securely and then close the ink tank unit cover.
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7. Hook the ink tank unit onto the printer.

Caution:
Make sure the transportation lock is set to the  printing position when using the printer, or 
ink will not be delivered and you may experience print quality problems. When transporting 
the printer, set the transportation lock to the  transport position or ink may leak.

8. Confirm the ID that is indicated on the ink bottle, and then follow the on-screen instructions to 
enter the ID and complete the refilling procedure.

2

1

1

2
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Adjust Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
Clean the Print Head
Align the Print Head
If you see ink on the back of a printout, you may need to clean the paper guide.

Clean the Print Head
If your printouts become too light, dots are missing, or you see dark or light bands across them, 
you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print 
quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.
Note:
You cannot clean the print head if an ink tank is expended, and may not be able to clean it when 
the ink level is low. You must refill the tank first.
Follow the instructions in these sections to check your print head nozzles and clean them:
Check the Print Head Nozzles
Clean the Print Head Nozzles

Check the Print Head Nozzles
You can print a nozzle check pattern to check for clogged nozzles using the printer’s buttons or 
your software.

Using the Printer Buttons

1. Make sure that no lights are indicating errors, that the CD/DVD tray is not inserted in the 
printer, and that the output tray is in the paper position.

2. Load a few sheets of plain paper in the sheet feeder.
3. Turn off the printer.

4. Hold down the paper button as you press the power button to turn the printer back on. 
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5. Check the printed pattern to see if there are gaps in the lines.

6. If there are no gaps, the print head is clean and you can continue printing.
If there are gaps or the pattern is faint, clean the print head.

From the Computer

1. Make sure that no lights are indicating errors, that the CD/DVD tray is not inserted in the 
printer, and that the output tray is in the paper position.

2. Load a few sheets of plain paper in the sheet feeder.
3. Do one of the following:

Windows: Right-click the printer icon in the taskbar.
Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select 
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select 
Utility and select Open Printer Utility.
Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & 
Fax, select your product, and select Open Print Queue. Select Utility.

Nozzles are clean

Nozzles need cleaning
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4. Select Nozzle Check.
5. You see one of these windows:

6. Click Print.
7. Check the printed pattern to see if there are gaps in the lines.

8. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Clean the Print Head Nozzles
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean 
the print head.
Note:
You cannot clean the print head if an ink tank is expended, and may not be able to clean it when 
the ink level is low. You must refill the ink tank first.
You can clean the print head using the printer’s buttons or the printer’s software.

Nozzles are clean

Nozzles need cleaning
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Using the Printer Buttons

1. Make sure that no lights are indicating errors, that the CD/DVD tray is not inserted in the 
printer, and that the output tray is in the paper position.

2. Load a few sheets of plain paper in the sheet feeder.

3. Hold down the ink button for at least 3 seconds to start the cleaning cycle.

The power light flashes throughout the cleaning cycle and stays on green when the 
cleaning cycle is finished.
Caution:
Never turn off the printer during a cleaning cycle or you may damage it.

4. Run a nozzle check to confirm that the print head is clean.
You may need to clean the print head up to 3 times. If print quality has still not improved, contact 
Epson.

From the Computer

1. Make sure that no lights are indicating errors, that the CD/DVD tray is not inserted in the 
printer, and that the output tray is in the paper position.

2. Load a few sheets of plain paper in the sheet feeder.
3. Do one of the following:

Windows: Right-click the printer icon in the taskbar.
Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select 
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select 
Utility and select Open Printer Utility.
Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & 
Fax, select your product, and select Open Print Queue. Select Utility.

4. Select Head Cleaning.
You see one of these windows:
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5. Click Start to begin the cleaning cycle, which lasts around 1 minute.
The power light flashes throughout the cleaning cycle and stays on green when the cycle is 
finished.
Caution:
Never turn off the printer during a cleaning cycle.

6. When the power light stops flashing and remains on, you can check to see if the nozzles are 
clean; click Print Nozzle Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.

8. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 3 times, run a power cleaning 
cycle from the Head Cleaning utility.

Nozzles are clean

Nozzles need cleaning
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Note:
Power cleaning consumes more ink than normal cleaning. If you perform power cleaning when 
the remaining ink in the tank is low, the print quality may not improve completely. If the alert 
screen appears on the computer’s screen, you have to click the Continue button and then run the 
power cleaning utility again, or refill the ink and then run the power cleaning utility again. If print 
quality does not improve, contact Epson.

To maintain print quality, print a few pages on a regular basis.

Align the Print Head
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see 
dark or light horizontal bands, you may need to align the print head. 
Note:
Banding may also occur if your print head nozzles need cleaning.
1. Make sure that no lights are indicating errors, that the CD/DVD tray is not inserted in the 

printer, and that the output tray is in the paper position.
2. Load a few sheets of plain paper in the sheet feeder.
3. Do one of the following:

Windows: Right-click the printer icon in the taskbar.
Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select 
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select 
Utility and select Open Printer Utility.
Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & 
Fax, select your product, and select Open Print Queue. Select Utility.

4. Select Print Head Alignment.
5. Click Next, then Print to print the alignment sheet. 

Note:
Do not press the product’s paper button to cancel printing while you are printing a test 
pattern with the Print Head Alignment utility.

6. Check the printed pattern and follow the instructions on the screen to choose the number 
representing the best printed pattern for each set.
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If no patterns are aligned in one or more of the sets, choose the closest one in each set and 
click Realignment. Then print another alignment sheet and check it. 

7. When you’re done, click Finish.

Clean the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide to remove any excess ink.
1. Make sure that no lights are indicating errors, that the CD/DVD tray is not inserted in the 

printer, and that the output tray is in the paper position.
2. Load a few sheets of plain paper in the sheet feeder.

3. Right-click the paper button on the printer’s control panel to feed and eject the paper.
4. Repeat as necessary until the paper comes out clean. 
Caution:
Do not apply grease to the metal parts under the print head.

Be careful to keep water away from the electronic components.

Do not spray the inside of the printer with lubricants.
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Solve Problems
If you have a problem using your printer, check these sections for guidance in diagnosing and 
solving the problem:
Check for Software Updates
Problem-solving Tools 
Problems and Solutions
Re-install Software
Get More Help

Check for Software Updates
Periodically, it’s a good idea to check Epson’s support website for free updates to your printer 
software (website available only in Spanish and Portuguese).

With Windows, you can manually update the software by selecting Driver Update on the 
Maintenance tab in the printer settings window. You can also click  or Start, select All 
Programs or Programs, select EPSON, select EPSON L800 Series, and click Driver Update.

Problem-solving Tools
You can often diagnose problems with your printer by checking the status of lights on the control 
panel.
If the lights do not help you solve your problem, check for additional solutions.
If you need to determine if the printer is operating properly, run a printer check.

Check the Lights on Your Product

Power 
button 
and light

Ink button 
and light

Paper 
button 
and light

http://global.latin.epson.com/Soporte
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Check the Lights on Your Printer

Lights Problem and solution

Paper out

No paper is loaded. Load paper into the sheet feeder, and 
then press the paper button. The 
printer resumes printing and the light 
goes out.

CD/DVD tray error

When printing on a CD or DVD, the 
CD/DVD tray is not inserted.

Insert the CD/DVD tray in the printer 
and press the paper button.

Multiple feed error

The printer has fed more than one 
sheet of paper at a time.

Make sure you set the output tray to 
the paper position. Then, load paper 
in the sheet feeder and press the 

paper button to resume printing.

Paper jam

Paper has jammed in the printer. Clear the paper jam.

CD/DVD tray jam

When printing on a CD or DVD, the 
CD/DVD tray is not ejected.

Pull out the CD/DVD tray and press 
the paper button.

Ink level reaches the lower line

Ink level may have reached the lower 
line.

To confirm the actual ink remaining, 
visually check the ink levels in the 
printer’s ink tanks.
If the ink level reaches the lower line, 
refill the appropriate ink tank.
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Run a Printer Check
A printer check will help you determine if the printer is operating properly.
Before running a printer check, make sure the output tray is in the paper position
1. Turn off the printer.
2. Disconnect the USB cable.

Ink level is low

Ink level may be low. You may continue printing. To 
confirm the actual ink remaining, 
visually check the ink levels in the 
printer’s ink tanks. Epson 
recommends that you continue using 
the printer until the ink level reaches 
the lower line so that the ink tank can 
be refilled with the entire contents of 
a new ink bottle.

Cover open

The printer cover is open. Close the printer cover.

Output tray error

The output tray is not in the correct 
position.

Before turning on the printer, make 
sure the output tray is set to the paper 
(lower) position. 
When printing on a CD or DVD, set 
the output tray to the CD/DVD 
position.
When printing on paper, set the 
output tray to the paper position.

Flashing 
alternately

Maintenance

The printer’s ink pads are at the end 
of their service life.

Contact Epson support to replace ink 
pads.

Unknown printer error

An unknown printer error has 
occurred.

Turn off the printer. Open the printer 
cover and remove any paper or other 
obstruction from the paper path. Then 
turn the printer back on. If the error 
does not clear, contact Epson.
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3. Load plain paper in the sheet feeder and make sure that the CD/DVD tray is not inserted in the 
printer.

4. Hold down the paper button as you press the power button to turn the printer back on. 
Hold down both buttons until the printer turns on, then release both buttons.

5. The printer begins printing the nozzle check pattern.
• If the page prints, the printer is operating properly. Your problem may be caused by your 

computer, cable, software, or settings. Check for additional solutions or re-install your 
software.
If the pattern on the page has gaps, clean or align the print head.

• If the page does not print, the printer may have a problem. Check for additional solutions. 
If they don’t work, contact Epson.

Problems and Solutions
Check these sections for solutions to problems you may have using the product:
Setup Problems
Miscellaneous Problems
Paper Problems
Printing Problems
Page Layout and Content Problems
Print Quality Problems
If none of the solutions here solve your problem, contact Epson for help.
See also:
Problem-solving Tools
Re-install Software
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Setup Problems
Noise After Ink Installation
Software Installation Problems

Noise After Ink Installation

• The first time you fill the ink tanks, the product must charge its print head for about 
20 minutes. Wait until charging finishes (the power light stops flashing) before you turn off 
the printer, or it may charge improperly and use excess ink the next time you turn it on.

• If the printer stops moving or making noise, but the power light is still flashing after 5 
minutes, turn off the printer. If the light is still flashing when you turn it back on, contact 
Epson for help.

Software Installation Problems

• Make sure your printer is turned on and the USB cable is securely connected at both ends. If 
you still have problems, disconnect the USB cable and carefully follow the software 
installation instructions on the Start Here sheet. Also make sure your system meets the 
requirements.

• Close your other programs, including any screen savers and virus protection software, and 
install the software again.

• Make sure the EPSON L800 is selected as the default printer and that the correct port is 
shown in the printer properties.

• If you see an error message or your software doesn’t install correctly, you may not have 
software installation privileges. Contact your System Administrator.

• Make sure the USB Controller is working properly in Device Manager. See your Windows 
help system for details. If it’s not working, contact your computer manufacturer.

• If you’re printing over a network, setup network printing.

Miscellaneous Problems
Red Light Inside the Printer After Power Off

Red Light Inside the Printer After Power Off

The light may stay on for 15 minutes and then go off automatically. This is normal.

Paper Problems
Paper Does Not Feed Correctly
Paper Jams
Paper Does Not Eject or Ejects Wrinkled

Paper Does Not Feed Correctly

• If paper doesn’t feed, remove it from the sheet feeder. Reload it against the right side, behind 
the tab. Slide the edge guide and against the left side of the paper, but not too tightly. Make 
sure the stack of paper is not above the arrow marks inside the edge guide.



70

• If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to 
separate the sheets, then reload it.

• If paper is jamming when you are inserting only one or two sheets, try loading more pages at a 
time. However, do not load more than the recommended number of sheets. 

• If you’re printing on both sides of the paper, try loading fewer sheets.
• Use new, smooth, high-quality paper that is not curled, creased, old, or too thin. Make sure to 

load it printable side up.
• Do not load paper that is too thick for the printer. 
• Do not load paper with holes punched in it.

Paper Jams

If paper jams, follow these steps to clear it:
1. Cancel the print job, if necessary.
2. Gently pull the jammed paper from the output tray or sheet feeder.

3. If paper is stuck inside, open the printer cover, then remove all of the paper inside the printer, 
including any torn pieces. Close the printer cover. If paper remains in the sheet feeder, gently 
pull it out, then carefully reload paper and press the paper button to resume printing. 
Warning:
Be careful not to pull the cables or ink tubes, or touch other components inside the printer 
unnecessarily. Otherwise, ink may leak or the printer may be damaged.
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4. If you cancelled the print job, relaunch it.
Note:
The product won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface that 
extends beyond the base in all directions.

Paper Does Not Eject or Ejects Wrinkled

• If the paper doesn’t eject fully, you may have set the wrong paper size. Press the paper 
button, then open the printer cover and remove the paper. Select the correct paper size when 
you reprint.

• If it’s wrinkled when it ejects, the paper may be damp or too thin. Load new paper. Make sure 
the paper Type or Media Type setting matches the paper you loaded.

Printing Problems
Nothing Prints, Even Though the Printer Is Turned On
Printing Noise Occurs, Even Though Nothing Prints
Noise Occurs When Printer Sits for a While
No Printer Icon Appears in Windows Taskbar
Slow Printing

Nothing Prints, Even Though the Printer Is Turned On

• Make sure the USB cable is connected securely at both ends and meets the requirements.
• If you are connecting the printer to your computer via a USB hub, connect the printer to the 

first-tier hub from your computer. If the printer driver is still not recognized on your computer, 
try to directly connect the printer to your computer without the USB hub. 

• Run a printer check. If the test page prints, make sure your software is installed correctly. 
• Clear any stalled print jobs from the Windows Spooler:
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Windows 7: 
Click  and select Devices and Printers. Then right-click EPSON L800 Series, select See 
what’s printing, right-click the stalled print job, and click Cancel and then Yes.
Windows Vista: 
Click , select Control Panel, and click Printer under Hardware and Sound. Then right-
click EPSON L800 Series, select Open, right-click the stalled print job, and click Cancel and 
then Yes.
Windows XP: 
Click Start and select Printers and Faxes. (Or open the Control Panel, select Printers and 
Other Hardware if necessary, and then Printers and Faxes). Then right-click EPSON L800 
Series, select Open, right-click the stalled print job, and click Cancel and then Yes.

Printing Noise Occurs, Even Though Nothing Prints

• Check to see if the print head nozzles are clogged.
• The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface 

that extends beyond the base in all directions.

Noise Occurs When Printer Sits for a While

The printer is performing routine maintenance.

No Printer Icon Appears in Windows Taskbar

Try restarting your computer. If you still don’t see the icon, follow these steps:
1. Do one of the following:

Windows 7: 
Click  and select Devices and Printers. 
Windows Vista: 
Click , select Control Panel, and click Printer under Hardware and Sound.
Windows XP: 
Click Start and select Printers and Faxes. (Or open the Control Panel, select Printers and 
Other Hardware if necessary, and then Printers and Faxes).

2. Right-click EPSON L800 Series and select Printing preferences or Properties. 
3. Click the Maintenance tab.
4. Click the Speed & Progress button, then click the Monitoring Preferences button.
5. Click the Shortcut Icon box. Then click OK to close the open windows.

Slow Printing

Make sure your system meets the requirements. If you’re printing a high-resolution image, you 
need more than the minimum requirements listed. You may also need to:
• Clear space on your hard drive or run a defragmentation utility.
• Close programs that you’re not using.
• Increase your system’s memory.
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For the fastest printing, try these tips:
• Choose the Black/Grayscale or Grayscale option in your printer settings if your document 

doesn’t include color.
• Choose Draft or Text for the print quality.
• Turn on the high speed setting in the Windows or Mac OS X printer software.
• If Plain Paper/Bright White Paper is selected as the paper type, choose Economy or Fast 

Economy for the print quality.
• Make sure the paper Type or Media Type setting matches the paper you loaded.
• For Windows, click the Speed & Progress button in the Maintenance tab of the printer 

settings window and activate the following settings: High Speed Copies, Always spool 
RAW datatype, Page Rendering Mode, and Print as Bitmap. (For more information on 
each of these settings, click Help in the Speed & Progress window.)

• If the printer is connected to a USB hub, disconnect unused USB devices.

Page Layout and Content Problems
Blank Pages Print
Too Many Copies Print
Incorrect Margins
White Border on Borderless Photo
Incorrect Characters Print
Incorrect Image Size or Position

Image Is Inverted Like a Mirror Image

• Turn off the mirror setting in your application program. 
• Turn off the Mirror Image setting in the printer driver in the Page Layout window 

(Windows) or Print Settings window (Mac OS X). If you are printing on EPSON Iron-on Cool 
Peel Transfer Paper, however, the image should be inverted.

Blank Pages Print

• Make sure EPSON L800 is selected as your printer.
• Select the Skip Blank Page setting.
• Check to see if the print head nozzles are clogged.

Too Many Copies Print

Make sure that the Copies option in your printer software or program is not set for multiple 
copies.

Incorrect Margins

• Make sure the paper settings are correct for your paper size in the Windows or Mac OS X 
printer software.
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• Choose the correct margins for your paper size in your printing program.
• Use the Print Preview option in your Windows printer software to check your margins before 

you print.
• Make sure your paper is positioned against the right side of the sheet feeder.

White Border on Borderless Photo

• Make sure you are printing on a paper that supports borderless printing.
• In the Windows printer software, make sure you selected the Borderless option.

In the Mac OS X printer software, make sure you selected a Paper Size listed as Sheet 
Feeder - Borderless or click the Borderless checkbox.

• Use the Expansion setting in the Windows or Mac OS X printer software to adjust how the 
image fits on the page. 

• Do not choose a custom paper size setting when printing borderless photos.

Incorrect Characters Print

• Make sure the USB cable is securely connected and meets the requirements. Then try printing 
again.

• Make sure your printer is selected as the active printer in your printing program.
• If you’re using a switch box or USB hub with your printer, connect the printer directly to your 

computer.
• Turn the printer off and then on again.

Incorrect Image Size or Position

• Make sure the paper and layout options are set correctly in your Windows or Mac OS X 
printer software.

• Make sure your paper is positioned against the right side of the sheet feeder.

Print Quality Problems
If your printout has a quality problem but the image looks fine on your computer screen, check the 
solutions in this section.
Printout Has White or Dark Lines Across It
Printout Is Blurry or Smeared
Printout Is Faint or Has Gaps
Printout Is Grainy
Incorrect Colors in Printout
Printout Is Slanted

Printout Has White or Dark Lines Across It

• The print head nozzles may need cleaning. 
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• Select a higher print quality and turn off the high speed setting in the Windows or Mac OS X 
printer software.

• Make sure the paper Type or Media Type setting matches the paper you loaded.
• Make sure the printable side of the paper is faceup. It’s usually brighter or whiter.
• Make sure you are using genuine EPSON inks.
• Align the print head.

Printout Is Blurry or Smeared

• Make sure your paper isn’t damp, curled, old, or loaded face down (the printable side should 
be face up).

• If you’re printing on thick paper or envelopes, do one of the following: In Windows, select the 
Maintenance tab in your printer settings, select Printer and Option Information, then 
select Thick Paper and envelopes. For Mac OS X, select Thick paper and envelopes in the 
Driver tab.

• Use a support sheet with special paper, or try loading your paper one sheet at a time.
• Make sure your paper meets the specifications.
• Use EPSON papers to ensure proper saturation and absorption of genuine EPSON inks.
• Use genuine EPSON inks.
• Align the print head.
• Make sure the paper Type or Media Type setting matches the paper you loaded.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• If ink smears on the back of a printout, clean the paper guide.
• Turn off the high speed setting in the Windows or Mac OS X printer software.
• If you are using double-sided paper and printing heavily saturated or dark images on the 

output side of the paper, you may notice that smudges or marks appear on the output when 
you print the second side. If one side of the paper will contain a lighter image or text, print that 
side first to eliminate marks or smudging.

• The print head nozzles may need cleaning. 
• The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface 

that extends beyond the base in all directions.
• Clean the paper guide.

Printout Is Faint or Has Gaps

• The print head nozzles may need cleaning. 
• Make sure the paper Type or Media Type setting matches the paper you loaded.
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• Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, reload a new 
stack of paper with the printable side up; it’s usually brighter or whiter than the other side. For 
best results, use genuine EPSON paper.

• Clean the paper guide.

Printout Is Grainy

• Make sure the printable side of the paper is face-up. It’s usually brighter or whiter.
• Select a higher Quality Option or Print Quality, and turn off the high speed setting and Fast 

Economy or Economy mode in the Windows or Mac OS X printer software.
• Select Best Photo for the Quality Option (Windows) or Photo RPM for Print Quality (Mac 

OS X). Remember that this setting increases print time.
• Align the print head.
• You may need to increase the image resolution or print in a smaller size; see your software 

documentation.

Incorrect Colors in Printout

• Make sure the initial ink charging is complete.
• Make sure the transportation lock is in the unlocked position.
• Make sure your Windows or Mac OS X printer software is not set to print in black or 

grayscale.
• The print head nozzles may need cleaning. 
• If you have not used the printer in a long time, run a power cleaning.
• Try turning off Fix Photo in the Windows or Mac OS X printer software.
• Try changing the Gamma setting in your Windows or Mac OS X printer software.
• Your printed colors can never exactly match your on-screen colors. However, you can use a 

color management system to get as close as possible. Try using the ICM setting (Windows) or 
the ColorSync setting (Mac OS X).

• In Windows, try enabling or disabling the Allow Applications to Perform ICM Color 
Matching setting. To access this setting, click the Speed & Progress button in the 
Maintenance tab of the printer settings window.

• For best results, use genuine EPSON ink and paper.

Printout Is Slanted

• Make sure the edge guide is against the left side of the paper.
• If you’re using Fast Economy or the high speed setting in the Windows or Mac OS X printer 

software, select a higher print quality setting.

CD/DVD Printing Problems
If you have trouble printing on a CD or DVD, check the solutions in this section.
Images and Text Not Centered
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Ink Smears or Printing Is Too Light
CD/DVD Tray Ejected or Won’t Feed

Images and Text Not Centered

Adjust the print position in your EPSON Print CD for Windows or Mac OS X. 

Ink Smears or Printing Is Too Light

• Make sure you’re using ink jet-printable CDs or DVDs.
• Handle the disc carefully and allow the ink to dry for at least 24 hours before playing the disc 

or inserting it in a drive.
• Adjust the print position in your EPSON Print CD software. 
• Adjust the brightness or contrast in your EPSON Print CD software for Windows or Mac OS 

X.

CD/DVD Tray Ejected or Won’t Feed 

• Reinsert the CD/DVD tray correctly.
• If the tray is ejected when you start a print job, the printer is not ready. Wait until you see a 

message on your screen asking you to insert the tray. Then reinsert the tray and press the 
paper button.

Re-install Software
If you have a problem that requires you to re-install your software, follow the instructions in one 
of these sections.
Windows
Mac OS X

Windows
1. Turn off the printer.
2. Disconnect the USB cable from the printer.

3. Click  or Start, and select All Programs or Programs.
4. Select EPSON, select EPSON L800 Series, then click EPSON Printer Software Uninstall.

Note:
If you see a User Account Control window, click Yes or Continue. Then go to the next step.

5. In the next window, select EPSON L800 Series and click OK.
6. When the confirmation screen appears, click Yes and follow the on-screen instructions to 

uninstall the printer software.
7. Restart your computer, then see the Start Here sheet to re-install your software.

Mac OS X
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In most cases, you do not need to uninstall your product software before re-installing it. However, 
you can download the Uninstall Center utility from the Epson support website to uninstall your 
product software as described here.
Note:
If you find that re-installing your product software does not solve a problem, contact Epson.
1. To download the Uninstall Center utility, visit the Epson download site at 

global.latin.epson.com/Soporte.
2. Follow the instructions on the screen to install the Uninstall Center.
3. Quit all applications currently running on your Mac.
4. Double-click the Uninstall Center icon.
5. Select the checkbox for each software program you want to uninstall.
6. Click Uninstall.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the Start Here sheet for instructions.
Note:
If you uninstall the printer driver and your product name remains in the Print & Fax or Print & 
Scan window, select your product name and click the – (remove) icon to remove it.

Get More Help
If you need additional help with your printer or its software, contact Epson.
Epson provides these technical support services:
Internet Support
Visit Epson’s support website for your L800 printer for solutions to common problems. You can 
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with 
your questions (site available in Spanish and Portuguese only).
Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name (L800)
• Product serial number (located on the back of the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem

Country Telephone Number

Argentina (54 11) 5167-0300

http://global.latin.epson.com/Soporte
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* Contact your local phone company to call this toll free number from a mobile phone.
** Dial first 7 digits, wait for a message, then enter code.
Note:
If your country is not listed, contact the Epson sales office in the nearest country.
Purchase Supplies and Accessories
You can purchase genuine EPSON ink and paper from an authorized reseller. To find the nearest 
one, call your nearest Epson sales office as described above.

Bolivia* 800-100-116

Chile (56 2) 484-3400

Colombia (57 1) 523-5000

Costa Rica 800-377-6627

Dominican Republic* 1-888-760-0068

Ecuador* 1-800-000-044

El Salvador* 800-6570

Guatemala* 1-800-835-0358

Honduras** 800-0122 
Code: 8320 

Mexico
Mexico City
Other Cities

(52 55) 1323-2052
01-800-087-1080

Nicaragua* 00-1-800-226-0368

Panama* 00-800-052-1376

Peru
Lima 
Other cities

(51 1) 418-0210
0800-10126

Uruguay 00040-5210067

Venezuela (58 212) 240-1111

Country Telephone Number
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Clean and Transport Your Product
If your printer gets dirty or you need to move it some distance, follow the instructions in these 
sections:
Cleaning
Transportation

Cleaning
To keep the printer working at its best, you should clean it several times a year.
Caution:
Do not use a hard brush, benzene, alcohol, or paint thinner to clean the printer or you may damage 
it. Do not use oil or other lubricants inside the printer or let water get inside it.
Note:
After using the printer, close the paper support and the front cover to protect the printer from dust.
1. Turn off the printer.
2. Unplug the power cable.
3. Disconnect the USB cable.
4. Remove all the paper.
5. Clean the sheet feeder using a soft brush.
6. Clean the outer case with a soft cloth dampened with mild detergent.

Transportation
If you need to ship your printer or transport it a long distance, prepare it for transportation as 
follows:
Caution:
When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside 
down; otherwise ink may leak.

When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not 
subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink 
bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and 
take measures to prevent ink from leaking when you transport the bottle.
1. Open the printer cover and check that the print head is all the way to the right (the home 

position). If not, turn on the printer.
2. Turn off the printer.
3. Unplug all the connected cables.
4. Remove all the paper.
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5. Open the printer cover, then secure the print head with tape, as shown below.

6. Close the front cover, then close the paper support.

7. Set the transportation lock to the  transport position.

8. Pack the printer in its original box or one of a similar size using protective material to keep it 
from moving inside the box.

Keep the printer level during transportation.
After you move it, set the transportation lock to the  printing position. If print quality has 
declined when you print again in a new location, clean and align the print head.
Note:
Be sure to remove the tape inside the printer and any protective materials before you print.
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Use Your Product on a Network
To use your printer over a small computer network, you need to install your printer software on 
the networked computer as necessary, and set up network printing.
Note:
If you want to print over a large network, consult your network administrator for setup 
instructions.
Follow the instructions in these sections for the network operating system you are using:
Windows 7, Windows Vista, and Windows XP Network Setup
Mac OS X Network Setup

Windows 7, Windows Vista, and Windows XP Network Setup
Install the product’s software on the computer to which you connected it. Then follow the 
instructions in these sections to share it and access it for printing.
Set Up Shared Printer
Access Shared Printer Over the Network

Set Up Shared Printer

1. Do one of the following:
Windows 7: 
Click , then click Devices and Printers. 
Windows Vista: 
Click , click Control Panel, and click Printer under Hardware and Sound.
Windows XP: 
Click Start, click Control Panel, and click Printers and Other Hardware or Printers and 
Faxes.

2. Do one of the following:
Windows 7: 
Right-click the EPSON L800 Series icon, click Printers properties, click the Sharing tab, 
then click the Change sharing options button
Windows Vista: 
Right-click the EPSON L800 Series icon, then click Sharing. Click Change sharing 
options button and click Continue. 
Windows XP: 
Right-click the EPSON L800 Series icon, then click Sharing.

3. Click Share this printer, then type a name for the shared printer. Do not uses spaces or 
hyphens in the name.
Note:
If you want to automatically download printer drivers for computers that are running different 
version of Windows, click Additional Drivers and select the environment and the operating 
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systems of the other computers. Click OK, then insert the printer software CD into the CD-
ROM drive.

4. Click OK or Close (if you installed additional drivers).
Now you can access the shared printer from other computers on the network.

Access Shared Printer Over the Network
Make sure you first set up the L800 as a shared printer.
1. Do one of the following:

Windows 7: 
Click , then click Devices and Printers. 
Windows Vista: 
Click , click Control Panel, and click Printer under Hardware and Sound.
Windows XP: 
Click Start, click Control Panel, and click Printers and Other Hardware or Printers and 
Faxes.

2. Do one of the following:
Windows 7 and Windows Vista: 
Click Add a printer.
Windows XP: 
Double-click the Add Printer icon. The Add Printer Wizard opens. Click Next. 

3. Do one of the following:
Windows 7 and Windows Vista: 
Click Add a network, wireless or Bluetooth printer, then click Next.
Windows XP: 
Select A network printer, or a printer attached to another computer, then click Next.

4. Follow the on-screen instructions to complete access to the shared printer. 
You may need to insert the CD that came with the L800 and click Have Disk.

Mac OS X Network Setup
Install the printer software on the Mac OS X to which you connected it. Then follow the 
instructions in this section to share and access it for printing. 
Set Up Shared Printer

Set Up Shared Printer
1. Turn on the printer.
2. Select System Preferences in the Apple menu or dock.
3. Select Print & Fax or Print & Scan.
4. Select your printer and click the Share this printer on the network checkbox.
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5. If you see a message telling you sharing is turned off, click the Sharing Preferences button 
and click the Printer Sharing checkbox.

6. Close System Preferences.
Now you can access the shared printer from other computers on the network. Just select the 
printer from the Format For menu (in the Page Setup window) or Printer menu (in the Print 
menu). Then select the rest of your settings and print your document or photo.
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Specifications and Notices
For information about using your printer and detailed specifications, see:
Important Safety Instructions
Computer System Requirements
Product Specifications
Copyright and Trademarks

Important Safety Instructions
Before using your printer, read and follow these safety instructions:
General Safety
Ink Safety

General Safety
• Do not block or cover the vents and openings in the printer.
• Use only the type of power source indicated on the printer’s label.
• Use only the power cord that comes with the printer. Use of another cord may result in fire or 

electric shock.
• The printer’s power cord is for use with the printer only. Use with other equipment may result 

in fire or electric shock.
• Be sure your AC power cord meets the relevant local safety standard.
• Avoid using outlets on the same circuit as photocopiers or air control systems that regularly 

switch on and off.
• Avoid electrical outlets controlled by wall switches or automatic timers.
• Keep the entire computer system away from potential sources of electromagnetic interference, 

such as loudspeakers or the base units of cordless telephones.
• Do not use a damaged or frayed power cord.
• The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and 

kinking. Do not place objects on top of the power-supply cords and do not allow the power-
supply cords to be stepped on or run over. Be particularly careful to keep all the power-supply 
cords straight at the ends and the points where they enter and leave the transformer.

• If you use an extension cord with the printer, make sure that the total ampere rating of the 
devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make 
sure that the total ampere rating of all devices plugged into the wall outlet does not exceed the 
wall outlet’s ampere rating.

• Never disassemble, modify, or attempt to repair the power cord, printer unit, or options by 
yourself, except as specifically explained in the printer’s documentation.

• Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:
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The power cord or plug is damaged; liquid has entered the printer; the printer has been 
dropped or the casing damaged; the printer does not operate normally or exhibits a distinct 
change in performance. 

• Do not adjust controls that are not covered by the operating instructions.
• When connecting the printer to a computer or other device with a cable, ensure the correct 

orientation of the connectors. Each connector has only one correct orientation. Inserting a 
connector in the wrong orientation may damage both devices connected by the cable.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are 
fuses in the plug, make sure you replace them with fuses of the correct size and rating.

• Place the printer on a flat, stable surface that extends beyond the base of the printer in all 
directions. If you place the printer by the wall, leave more than 4 inches (10 cm) between the 
back of the printer and the wall. The printer will not operate properly if it is tilted at an angle.

• When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside 
down. Otherwise, ink may leak.

• Allow spaces behind the printer for the cables, and leave enough space in front of the printer 
for the paper to be fully ejected.

• Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer 
away from direct sunlight, strong light, or heat sources.

• Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in 
locations subject to shocks, vibrations, high temperature or humidity. Do not use with wet 
hands.

• Place the printer near a wall outlet where the plug can be easily unplugged.
• Do not insert objects through the slots in the printer.
• Take care not to spill liquid on the printer.
• Do not put your hand inside the printer during printing.
• Do not touch the white flat cable and ink tubes inside the printer.
• Do not use aerosol products that contain flammable gases inside or around this printer. Doing 

so may cause fire.
• Do not move the print head by hand; otherwise, you may damage the printer.
• Always turn the printer off using the power button. When this button is pressed, the 

power button light flashes. Do not unplug the printer or turn off the power at the outlet until 
the power button light stops flashing.

• Before transporting the printer, make sure that the print head is in the home (far right) 
position.

• Refill ink when the ink level is below the lower line on the ink tank. Continued use of the 
printer when the ink level is below the lower line could damage the printer.

• If you are not going to use the printer for a long period, be sure to unplug the power cord from 
the electrical outlet.
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Ink Safety
• Keep ink bottles and the ink tank unit out of the reach of children. Do not allow children to 

drink from or handle them.
• Do not tilt or shake an ink bottle after removing its seal; this can cause leakage.
• Be careful not to touch any ink when you handle the ink tanks, ink tank caps, and opened ink 

bottles or ink bottle caps. If ink gets on your skin, wash the area thoroughly with soap and 
water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision 
problems remain after a thorough flushing, see a doctor immediately.

• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

• Store ink bottle in a cool, dark place.
• When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do 

not subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on 
the ink bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the 
cap, and take measures to prevent ink from leaking when you transport the bottle.

Computer System Requirements
To use the printer and its software, your computer system should meet or exceed the requirements 
in these sections:
Windows Requirements
Mac OS X Requirements
Note:
Visit Epson’s support website for the latest in compatibility and drivers for Epson’s L800 printer 
(website available only in Spanish and Portuguese).

Windows Requirements
Your system should include: 
• Microsoft® Windows 7, Windows Vista, Windows XP Professional x64 Edition, or Windows 

XP
• USB 1.1 port (minimum) or USB 2.0 port (recommended).
• A shielded USB “AB” cable up to 6.5 feet (2 meters) long. Using an improperly shielded USB 

cable may cause your EPSON printer to malfunction.

Mac OS X Requirements
Your system should include:
• Mac OS X 10.5.8, 10.6.x, 10.7.x, 10.8.x
• A shielded USB “AB” cable up to 6.5 feet (2 meters) long. Using an improperly shielded USB 

cable may cause your EPSON printer to malfunction.

http://global.latin.epson.com/Soporte
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Product Specifications
See these sections for the detailed specifications of your product:
Printing
Paper
CD/DVD
Ink Bottles
Size and Weight
Electrical
Environmental
Interface
See also:
Computer System Requirements
Important Safety Instructions

Printing
Paper path

Sheet feeder, top entry
Sheet feeder capacity

Single-sheets: Approx. 100 sheets at 17 to 24 lb (64 to 90 g/m2)
Legal-size paper: Load one sheet at a time
Envelopes: 10 envelopes

Paper
Use paper under normal conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH
Note:
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, Epson cannot guarantee the quality of any non-EPSON brand or type of paper. Always 
test a sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Size
A4 (210 × 297 mm [8.3 × 11.7 inches])
A6 (105 × 148 mm [4.1 × 5.8 inches])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 357 mm])



89

4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
8 × 10 inches (203 × 254 mm)
3.5 × 5 inches (89 × 127 mm)

Paper types
Plain paper
Special papers distributed by Epson

Thickness
0.003 to 0.004 inch (0.08 to 0.11 mm)

Weight
17 lb (64 g/m2) to 24 lb (90 g/m2)

Envelopes

Size
No. 10 (4.1 × 9.5 inches [105 × 241 mm])

Paper type
Plain bond paper

Weight
20 lb (75 g/m2) to 24 lb (90 g/m2) 

Printable Area

Note:
When printing borderless, quality may decline in the expanded printable area.
Single sheets

Top: 0.12 inch (3 mm) minimum
Left: 0.12 inch (3 mm) minimum
Right: 0.12 inch (3 mm) minimum

Top

Left Right

Bottom

Borderless printingSheets with borders
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Bottom: 0.12 inch (3 mm) minimum
Envelopes

Left: 0.12 inch (3 mm) minimum
Bottom: 0.20 inch (5 mm) minimum
Top: 0.20 inch (5 mm) minimum
Right: 0.78 inch (20 mm) minimum

CD/DVD

A: Inner margin: 0.7 inch (18 mm) maximum 
B: Outer margin: 4.7 inch (120 mm) maximum 

A: Inner margin: 0.7 inch (18 mm) maximum 
B: Outer margin: 3.2 inch (80 mm) maximum 
Note:
Avoid printing in the clear plastic areas of discs to prevent staining the disc with ink.

TopLeft

RightBottom

12-cm CD/DVD

8-cm CD/DVD
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Ink Bottles
Caution:
We recommend that you use genuine EPSON ink bottles. The use of other products may affect 
your print quality and could result in printer damage that is not covered by Epson’s warranty and 
under certain circumstances may cause erratic printer behavior.

For best printing results, use up the ink bottle before the date printed on the package. 

The ink in the ink bottles packaged with your printer is partly used during initial setup. In order to 
produce high quality prints, the print head in your printer will be fully charged with ink. This on-
off process consumes a quantity of ink and therefore these bottles may print fewer pages 
compared to subsequent ink bottles.

Yields may vary based images printed, print settings, paper type, frequency of use, and 
temperature. To ensure you receive premium print quality and to help protect your print head, a 
variable amount of ink remains in the ink tank after the “refill ink” screen comes on. The yields 
quoted do not include this reserve.

Although the ink bottles may contain recycled materials, this does not affect the product’s 
function or performance.
Color

Cyan, Light Cyan, Magenta,  Light Magenta, Yellow, Black
Part numbers and purchasing information

Ink bottle life
For best results, use ink within 6 months after removing the seal from the ink bottle

Temperature
Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Size and Weight
Size

Stored:
Width: 21.1 inches (537 mm)
Depth: 11.4 inches (289 mm)
Height: 7.4 inches (188 mm)
Printing:
Width: 21.1 inches (537 mm)
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Depth: 22.4 inches (571 mm)
Height: 11.4 inches (289 mm)

Weight (without the power cord and CD/DVD tray)
13.7 lb (6.2 kg)

Electrical
Power supply rating

120 V Model:
100 to 137 V
220 V Model:
220 to 240 V

Input voltage range
120 V Model:
90 to 132 V
220 V Model:
198 to 264 V

Rated frequency range
50 to 60 Hz

Input frequency range
49.5 to 60.5 Hz

Rated current
120 V Model:
0.6 A
220 V Model:
0.3 A

Power consumption
120 V Model:
Printing: Approx. 13.0 W (ISO/IEC24712)
Ready mode: Approx. 3.3 W
Sleep mode: Approx. 1.0 W
Power off mode: Approx. 0.2 W
220 V Model:
Printing: Approx. 13.0 W (ISO/IEC24712)
Ready mode: Approx. 3.3 W
Sleep mode: Approx. 1.2 W
Power off mode: Approx. 0.3 W

Environmental
Temperature
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Operation: 50 to 95 °F (10 to 35 °C)
Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
Operation: 20 to 80% RH
Storage: 5 to 85% RH
(without condensation)

Interface
Interface type

Hi-Speed USB (Device Class for Computers)

Copyright and Trademarks
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this EPSON printer. Epson is not responsible for 
any use of this information as applied to other printers.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product 
or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a 
result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or 
alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson 
Corporation’s operating and maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of 
any options or any consumable products other than those designated as Original EPSON Products 
or EPSON Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic 
interference that occurs from the use of any interface cables other than those designated as 
EPSON Approved Products by Seiko Epson Corporation.
Default Delay Times for Power Management for EPSON Products
This product will enter sleep mode after a long period of non-use. The time interval has been set at 
the factory to ensure that the product meets Energy Star standards of energy efficiency, and cannot 
be modified by the consumer. 
A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using 
any EPSON product. While some countries’ laws permit limited copying or reuse of copyrighted 
material in certain circumstances, those circumstances may not be as broad as some people 
assume. Contact your legal advisor for any questions regarding copyright law.
Trademarks
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EPSON is a registered trademark and EPSON Exceed Your Vision is a registered logomark of 
Seiko Epson Corporation.
General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.
This information is subject to change without notice.
© 2012 Epson America, Inc.
7/12
CPD-35589R1
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